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Preface

Copyright

Those portions of this manual which are unique to the application of informatio
as it applies to the software mentioned here-in are copyrighted with all righ
reserved. Under the copyright laws, this manual may not be copied, in whole or
part, without written consent of VAMP Inc., except in the normal use of the
software. The same proprietary and copyright notices must be affixed to at
permitted copies as were affixed to the original. This exception does not allo
copies to be made for others, whether or not sold.Under the law copying includ
translating into another language or format.

“APPLE” is a registered trademark of Apple Computer Inc.
“Macintosh” is a trademark licensed to Apple Computer Inc.
“McCAD” is a registered trademark of VAMP Inc.

“GLSS” is a trademark of VAMP Inc.

Windows 2K/XP/Vista/Win7 are trademarks of Microsoft Corporation
All other copyrights are the property of those who hold them.
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Technical Support

Technical support is available to licensed users of McCAD tools by callinp,
writing, faxing or E-mail:

Vamp Inc.
6753 Selma Ave.
Los Angeles, CA 90028

FAX (323) 466-8564
E-mail: support@mccad.com
WEB: http://www.McCAD.com

Before contacting Technical Support the user should be familiar with the
Microsoft Windows OS or Mac OS procedures and should have read this manpal.
Also, please itemize all questions on paper before calling.

Technical Support personnel will respond to questions regarding the operagon
and use of VAMP Inc. softwamnly.

Extended Software Support

After the initial 30 day support period, Extended Software Support is available for
an annual fee. It entitles the subscriber to updates, E-mail and phone support] For
additional information contact VAMP Inc.

VAMP Inc.

6753 Selma Avenue

Los Angeles, California 90028
USA

FAX: (323) 466-8564
E-mail: sales@mccad.com
WEB: http:/iww.McCAD.com
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Software Requirements

To use this documentation you will need to install McCAD
EDS on your Computer. This software is available from
http://www.McCAD.com. It is available for either MS Win-
dows or MacOS operating systems. Download whichever ar-
chive suits your needs.

Almost all of the example demonstrations can be done with the
SE versions of the EDS tool set. If you have the tool set alread
installed and licensed for PRO mode, then you will be able to
run some of the more demanding examples.

About the Screen Graphics

This manual was created using the Macintosh version of the

EDS tool set. The graphics in the MS Windows OS will look

very similar and so we have not included those to reduce the re
dundancy of information as much as possible.We have tried tc
focus the screen graphics within this manual as much as poss
ble to avoid the cosmetic differences of each OS’s windowing
display. The procedural information presented is the same for
both operating systems. Differences are noted where relevant.
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Chapter 1
Simple PCB Project

What follows is a simple example of a project starting with a schematic created in MCCAD Schemat
moving that project to the PCB layout environment and then having that layout partially auto-routec
McCAD Trailblazer.

This tutorial will provide you with the a starting foundation of how the system works. We will not cover ¢
aspects or features available in the respective tools which we will be using. Once you have completec
tutorial you should be able to begin your own projects.

This tutorial assumes that you have properly installed all of the tools that will we used. If not, install the tc
before proceeding.

The figures you will see for the most part come from the Macintosh versions of the applications.
Windows versions will look almost identical.

This Tutorial may also be used with the SE Series of tools.
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1-8 Simple PCB Project

Introduction

The McCAD EDS design system is comprised of independent modules
which work together. These modules are the Schematic, PCB-ST and
Gerber Translator. We will also demonstrate how McCAD Trailblazer can
be used to auto-route a layout to completion.

As part of this tutorial all of the files used in this tutorial can be found in the
PCB Tutorial Folder which is included with this tutorial archive.
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Creating the Schematic

Any project must have a complete schematic. All the symbols must be
properly attributed with the appropriate information before moving on to
the next step in the design phase. For this tutorial we will be creating a
simple OpAmp AM Modulator and putting it on to a PCB layout. If you have
already done the Simulation Quick-Start Tutorial you will recognize most
of the circuit.

The following circuit is based on the Op-Amp circuit which was created in
the simulation examples.

Creating a Project

1. Create afolder directory labelled MyPCBProjectFolder . Thisis where
you will put the various documents which you will be creating with this
tutorial. You may compare them with the files (found in PCB Tutorial
Folder found in the Examples Sub-Directory) which are also included
with this archive.

2. Begin by launching the McCAD Schematics module.

Creating a Library Symbol

Before creating the actual schematic drawing we will first create a
schematic symbol and save it into the Tutorial Library which is used in this

tutorial.

3. If a new untitled window is not displayed then in the File menu select
|EE' New Schematic . A blank untitled schematic sheet will now appear.
Libraty 4. Select the Library PopUp Button in the Overhead Tool Bar.

5. If everything was installed properly the software will display the
libraries that it has located.

6. In the popup menu that appears drop the pointer down to the
"FOLDERS > "item in the menu, This will cause a secordary popup

©VAMP Inc. McCAD® EDS Quick Start Guide
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menu to appear displaying the available library sub-directories that
were located.

Library Eﬁ
Access Library

Button New...

Open... I
Folders [ v *General

E ALS TTL
Capacitors AS TTL
annectors BB OpAmps
Diodes | cMmOs
Document Forms EDS Tutorial
FET Transistors = F17L

Figure 1-1 « Library Folder Sub-Directories

7. In that secondary menu select "EDS Tutorial ". This is where the
tutorial library for this tutorial is located.

8. Release the pointer and the reselect the Library Button in the tool bar.
This time you should see the EDS_TUTORIAL_LIB library at the
bottom of this popup.

(5E]] v P=
Lg ‘O\ |1 | =
New...
Open...

Folders >

EDS_Tutorial_lib

Figure 1-2 « Selecting Tutorial Library

9. Drop the pointer down to EDS_TUTORIAL_LIB selecting it. This will
open the library and place the first item in the library’s symbol list into
the view window ready for placement. A menu with the currently open

McCAD® EDS Quick Start Guide ©VAMP Inc.
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library file will also appear in the Menu Bar usually following the
Window Menu.

Utilities Window EDS_Tutorial_lib  Help
“p—

Capacitaor

: 1
Library T
View =
Pane

Library Contents

Figure 1-3 « Library Vew Pane and Menu Bar

10. Clicking in the Menu will reveal the content of the file and allow you to
select the available symbols.

EDS_Tutorial_lib

| ¥ Capacitor !
Fixed Resistor
1 LM741 l
MMBTS5088
A-Size (p)
Female Con Pin
T ——

Figure 1-4 « Tutorial Library Symbol Contents

To complete this tutorial we will need a six pin connector. We are going to
add it to the Tutorial Library.

11.Click in the Library View Pane below the Library and symbol names,
The window will high-light. This will also cause some of the commands
to change in the file menu. These commands are specific to working
with the library contents and accessing the library editor window.

12.With the library view pane highlighted select "New Library Window
in the FILE Menu.
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1-12 Simple PCB Project

13.The Library Editor window will appear.

"® O 6 NewSymbel 1

™
Rectangle —p-[1
O
AN

Pins —p «— | 0000

Figure 1-5 « Library Editor

14. Select the Rectangle drawing tool with the pointer. In the drawing area
of the Editor Window create a rectangle that is at least three (3) grid
units wide and fourteen (14) grid units tall.

15. Next select the the PINS tool . Then with the pointer at least two (2)
grid units to the right of the right side of the rect click and hold the
mouse button. Move the pointer to the left with the button still down.

16. Release the mouse button when you reach the right side of the
rectangle. A pin labeled "1" should appear.

[ Important Note:
Please note that this pin has a diamond at one end. The diamond is
the hot point recognized by the system when wiring your schematic.
The diamond is visible only on the screen. It will not appear in any
finished output.
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17.Repeat this process five more times placing the remaining pins;
spacing them two grid units apart. When done the connector should
look as in the figure below.

MNew Symbol 1

AP E

Figure 1-6 » User Created Connector Symbol

Before this symbol can be saved we need to specify the footprint we will
use in PCB-ST.

18. Select the pointer Mode. Move the pointer to the drawing area away
from the grapphics and double-click. This will bring up the Attributes
dialogue for this symbol.

r 5 1
Item Information

Value 1 Visible

ClassID 0

Y My Own&Pin

) User ® Interface ) Spice
Vicihla
S1ole

1 Transparent ( Cancel ) ( oK )

Figure 1-7 « Symbol Attributes Dialogue

19. Select the radio button labeled "Interface ". In the text field above this
button we can now enter the name of the PCB-ST footprint which is to
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1-14 Simple PCB Project

be associated with this schematic symbol. In this instance the name of
the footprint will be "MyOwn6Pin ". To speed the locating of this
footprint in PCB-ST we add the prefix "\F." which signals that this is a
user created footprint and not a Macro-generated symbol. Thus the
completed string is "\F.MyOwn6Pin ".
20.Click Ok to save the footprint attribute to the symbol data record.
21. Close the editor window by either clicking in the Window Close Button
or selecting close in the File Menu.
22.The system will present a dialogue to label the symbol you have
created.
NSO NATE i
Save Symbol As:
CON&

._\' Cancel I ( Save )

Figure 1-8 « Symbol labeling on closing window

23.Label the the symbol "CON6". Then select the Save button.
In summary this is what you have learned to this point:
¢ Locating and opening libraries

» Created a symbol and added it to the tutorial library
» Associated a footprint to the schematic symbol

Creating Sheets

24.1f a new untitled window is not displayed then in the File menu select
New Schematic . A blank untitled schematic sheet will now appear.

25.1n the File menu select Save and then title the drawing as
PCB_Example.scm . Be sure to place your sheet file in the
MyPCBProjectFolder.
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Drawing the Circuit

26.The symbols needed can be found in the EDS_TUTORIAL_LIB
library. Open that library.

1
Opdanp
5
1 ) ) 1
CONE Carrier " 3 Out
A A
1 =
3 R4 4
3 "y *
4 o 104k RZ
5 17p  EL 3k
6 10K F Ry Y pu—
—e%|—e—e—’\/\/\,—e—0 e
1F
=38
RS

1 2z Ik
V’—‘ py LMMETSDEE] 237 §
610 %
SHD *

Figure 1-9 « Op-Amp Based AM Modulator Circuit.

27.Complete the wiring of the circuit as shown in Figure 1-9. Using the
Placement tool and selecting the desired symbols from the Library
menu in the Menu Bar, place and arrange the symbols as shown.

Placement Tool ﬁ{l Utilities Window EDS_Tutorial_lib Help
* |

Figure 1-10 » Selecting & Enabling Placement

[0 Important Note:
To delete a placed symbol you first select it with a pointer and then use
the BackSpace or Delete keys . This also apples to wiring in the
schematic.
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28. Select the Wiring Tool which will automatically take to the Manual
Interconnect tool; the preferred method of connecting devices.
Complete the wiring so that it matches Figure 1-9.

I _u]_u_ I FManual

.a_

Figure 1-11 « Getting to the Manual Wiring tool

To complete the schematic we will need to assign all of the components
their appropriate Values and for those symbols which did not have
assigned footprints in the library we will need to assign the footprints at the
document level.

U IMPORTANT NOTE;
Many of the symbols in the schematic libraries do not have footprints
assigned. This is because the possible variants are enormous.
Therefore as you start to use the system you will either be creating
your own custom libraries or tailoring the existing libraries based on
the exact devices you will be using.

29. Double-Click on each of the following symbols in the schematic so that
the Attributes Dialogue for that symbol appears. In the Appropriate
fields enter the reference designator and value.

e R1->10K

e R2->3K

* R3->610

e R4 ->10.4K
e R5-> 1K

e R6 ->5K

e R7 > 1K

e C1->1uF

e C2->1uF

McCAD® EDS Quick Start Guide ©VAMP Inc.



Simple PCB Project 1-17

Item Information

Device Name  Fixed Rasistor 1 Visible
Ref. Designator R7 E Visible
Value 1K " Visible

ClassID 0

Figure 1-12 « Setting Value And Ref Designators

30. Repeat this for each component in the list.

At this point you have a wiring diagram of the circuit. However before you
can proceed to a layout of a PCB you will have to assign the footprints that
all of the components will be using.

31. Double-Click on R7 again. The will reveal the resistor symbol’s

attributes.
PADPRA RO 12231400
O User {® Interface O Spice
__ Visible
] Transparent ) )
] Reference Link (Cancel ) GO

Figure 1-13 « Lower Portion of Resistor Attributes Panel

32.Select the "Interface " Radio Button.

At this point we must specify a footprint in the text field above the button.
PCB-ST affords two methodologies for doing this. The first is the use of the
Macro-Generation and the second is a Specific Footprint Library Name
located in the PCB-ST's List of library footprints. Will will use both methods
so that you can see how both work.
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In the figure below you will find a summary of both footprint specification
techniques.

PCB-ST PARTS LIST REPORT FIELDS

; - 1 2 | a | 4 a
co |PART  |REF. VALUE | Reserved | FOOTPRINT NAME
£ |NAME  |DESIG-
g NATOR
o
TAB TAB TAB TAB cA |
1 2 a 4 g ] 7 B
PART REF. VALUE Reserved Egﬁf b ggUNT [} ACE
— N ROWSE,
NAME | DESIG HDIP PIN COUNT | ROWSPACE
NATOR VDBS PIN COUNT )
= TOS PIN COUNT [5)
=0 VEMDI® | PIN COUNT | ROWSPACE
EE HSMDIE | PIN COUNT | ROWSPACE
== vsoT PIN COUNT | ROWSPACE
A HSOT PIN COUNT | ROWSPACE
o ccp STYLE #
a FLTPK STYLE #

HEDGCON | PIN COUNT | PIN SPACE | PINWIDTH
VEDGCOM | PIN COUNT | PIN SPACE | PINWIDTH
ARRY HPINS GRID Y-PINS

EURC TYPE 18} PADS
PADPAR oo 18] PADSPACE
TAB TAB TAB TAB TAB TAB TAB A

Figure 1-14 « McCAD PCB-ST Parts List File Format

In the first example we will use ST’s internal macro generators. In the
above table we will look at columns 5 thru 8 in the lower half of that table.
For a simple two hole resistor we could use a pair of pads separated by a
specified distance. The macro name we will use is PADPR.

33.In the Interface Field of the dialogue for the symbol type the following:
PADPR\ t 60\ t 32\t 400

This specifies a 0.060" round pads, 0.032" drill hole and
a center to center distance of 0.400" .

[ Important Note:
The " \t” represents the TABs used as field separators as shown in the

previous table. These are required.

34.For the sake of simplicity we will use the same footprint string
specification for all of the resistors and capacitors in this project.
Therefore access all of the Attribute Panels for the resistors and
capacitors and use the same attribute & footprint specification shown.
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___________________________________________________________________________________________________________________|
35. Access the Attribute Panel for the Op-Amp. Create the Footprint
attribute and in the Attribute Data column type:

\F.DIP-8

DIP-8 is the actual name of a footprint that can be found in the
external footprint libraries shipped with the PCB-ST system.
The “\F.” is an optional prefix. It signals the PCB-ST to search
the external libraries first.

36. Access the Attributes Panel for the transistor. Create the Footprint
attribute and in the Attribute Data column type:

\ F. TO92A

TO92A is the actual name of a footprint that can be found in the
external footprint libraries shipped with the PCB-ST system.
The “\F.” is an optional prefix. It signals the PCB-ST to search
the external libraries first.

r ” hl
Item Information

Device Name MMETS0ES I Visible
Ref. Designator 121 E Visible
Value visible
ClassID 0
YWELTO92A
) User {® Interface ) spice
Visible
I Transparent E ;
s P € Cancel 3 ( EESP -V Be )

Reference Link

Figure 1-15 « Transistor with Footprint Attribute Specified

37.Access the Attribute Panel for the J1. Verify the Footprint attribute
and in the Interface Data is correct:

\F. \yOMnBPI n
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U Note:
MyOmG6PI n is the actual name of a footprint that will be found in the

external footprint libraries of PCB-ST system. This will be a Custom
Footprint which we will create later in this tutorial. The “\F.” is an
optional prefix. It signals the PCB-ST to search the external libraries
first. Either Footprint specification will work with the use of later prefix
allowing faster processing in large designs.

We have completed the creation of the schematic at this point. Before
proceeding to the PCB Layout we will extract a standard PCB-ST parts
file from the schematic.

ZIE8 Edit Project Text Layout Grid Utilities

New Schematic BN
Open Schematic... 30 ‘

Close Schematic HEW
Save Schematic HS
Save Schematic As...

Import ECO._. #l L

i Report...
Page Setup >
Print P ASCI Database...
_ DXF File...
PICT File...
S —

Figure 1-16 « Exporting an Parts list

You will be presented a number of format options for extraction. If the
dialogue is blank you must specify a report format. The report scripts can
be found in the following path link:

McCAD -> Essentials -> Schematics -> Report Formats

McCAD® EDS Quick Start Guide ©VAMP Inc.
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Besure to select McCAD Parts List.

? Select Report Type g
Format: McCad
MNet List —
Parts List (- Select Format... )
Wire List
Pin List

._\' Cancel I ( 0K }

This is not normally necessary but is handy in determining if you have
all of your components properly attributed. In the following two figures
you will first see an incomplete parts list (it was extracted before all
components were properly attributed) followed by a figure showing a
complete parts list record.

E v
866 = PCB Project Example.PARTS

BT List - TR it

C ci 1uF PADPR 6B 32 B L]
C cz 1uF PADPR 68 32 486
COMe& a1 SF L MyOwntPin

NP o1 HPHMPN

[ Rl 16k P&DPR 68 32 5]
[ Rz 3k P&DPR 68 3z b L]
R R3 16 PADPR 68 32 486
R R4 16 .4k PADPR 6B 32 486
R RE 1K PADFR &8 3z 488
R RE E@EA PADFR &8 3z 488
[ R7? 1K P&DPR 68 32 5]
Opénp - X1 OpAmpLH741

Figure 1-17 « Incomplete Part List.. with Errors

r al
ene =| PCB Project Example.PARTS

b e sl L 2 ki

c 1 1uF PADPR 68 3z 488
c cz 1UF PADPR 68 3z 488
CONG Ji SF JMyOwnGPin

PN 0l WF.TO924

R a8 16K FPADPR 6@ 32 488
R Rz 3k PADPR 68 3z 488
R R3 618 PADPR 68 3z 488
R R4 18.4k PADPR 68 3z 488
R [ 1K PADPR 68 32 488
5 3] [talals] FADFR 68 3z 408
R R? 1K FPADPR 6@ 32 488
Opdmp 21 “F.DIP-8

Figure 1-18 « Complete Parts List... No Errors
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To complete the schematic portion of this project we now need to extract
an ECO document. This stands for Engineering Change Order. This
document is used to synchronize the Schematic and Layout environments.

38.1n the File Menu select Export ->ECO .
ZIN Edit Project Text Layout Grid Utilities

New Schematic 3EN
Open Schematic... 30

Close Schematic ‘W
Save Schematic ®S
Save Schematic As...

Import ECO... %I

. Report...
Page Setup
Print > ASCII Database...
——— Y File
PICT File...

Figure 1-19 « Exporting an ECO document

39. Save your Project documents and close the Schematics application.
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Creating the PCB Layout

In this portion of the Tutorial Project we will take the ECO document
created in the Schematic Plus module and bring it into a blank layout
design window. We will build a custom footprint in the ST footprint library.
We will arrange the footprints in preparation for layout.

PCB-ST System Architecture

Before actually beginning the design we will momentarily divert the
discussion to a very brief description of how the design environment is
structurally set up. It is very important to understand this as it provides
tremendous flexibility when compared to other systems and failing to grasp
its method of use may lead to problems with some of your own designs in
the future.

The layout environment is made up of 32 individual layers. Each layer
behaves like a single sheet of transparent material upon which you may
place or draw graphics. Thus the environment is simply a stack of 32
transparent sheets. Clicking in the overhead tool bar on a specific layer
button informs the software that this is the sheet you will be working with
and therefore you want it to become active. The sheet which currently
active will have its layer button blink. When a screen is redrawn, the
currently active layer is always painted last thus moving it to the top of the
working stack on your computer screen.

To produce the individual production layers of a PCB, these individual
transparent layers are arranged in fabrication stacks known as
Fabrication Tooling definitions. These definitions are created using the
Create Fabrication Tooling command found in the Art Menu. In the
dialogue which appears you can specify which transparent layers are to be
combined to produced the necessary Photo tooling for each of your PCB’s
production layers. The definitions found in this dialogue represent the
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backbone definitions for your design and these definitions are also
instrumental in determining how your mouse clicks will be interpreted while
you are designing your board.

I -
Design Layer L1 1 H T 1
Top Silk I
| Fabrication Tool T1
u u u Top Silk
|
Dcesign Laygrld_z I
ommon Pads ° u u
1 R
TT11] I A Qg LLL)
Design Layer L8 - mEEn T3
Top Pads bl I ° n
|
Fabrication Tool T3
Component Side Copper
|
Design Layer L3 I
Top Trace
1
Data Layers 1 Defined Fab Composites

Figure 1-20 « ST System Architecture

Checked design layers are part of Fabrication Tool

Fabrication Tools: Tool Contents: Click here to
; T1: Top Legend L1: Top Silk add or remove
Click here t\ T2: Top Solder Resist v L2: Common Pads Design Layers
SeleCt a ~T3: Top Copper v L3: TOP Trace

L4: Inner 1
L5: Inner 2
L6: Bottom Trace

Fabrication Tool T4: Inner Signal 1
T5: Inner Signal 2
T6: Bottom Copper
T?: Gnd Plane L?: Bottom Silk
T8: Pwr Plane + L8: Top Pads

L9: Bottom Pads
. L10: Info (Copper) .
Click here to=== display only
change a Tool's S>how Enabled Layers Selected layer:

Name [EHNI:EL] [[ 0K ]] for the Tool

|, Click here to

Figure 1-21 « ST Tooling Dialogue
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For our current project we will use the default tooling setup as shipped with
the PCB-ST software. This configuration will meet the needs of most

designers.

Defining the PCB board’s perimeter

1. Launch the PCB-ST Module. You will be presented with a blank
untitled design window.

2. Inthe top level tools pallet on the left select the Board Layout Button.

N
°
B

Figure 1-22 « Selecting Board Definition Tools

3. Inthe new tool pallet, select the Perimeter Line tool.

e

SIEIFAEd P s
NEERPREEER

&

Figure 1-23 » Selecting the Perimeter Line Tool
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4. Carefully draw a rectangular boundary for the PCB design which is 3"

by 2".

re()f} Untitled 1 s 7
INT

Meb =) (el @ L

li ®: 2250  |[v: 1360 [common Pads

T@.D 2 E Y 'm

7Y -

o4

O|¢
..... = e ;

Figure 1-24 « Board Perimeter Defined

Importing the Schematic’s ECO

5. Inthe File Menu select Import -> ECO . You will be presented with an
OPEN dialogue. Locate the ECO you created in the Schematics
portion of this tutorial and select OPEN.

"noe Select ECO File )

(«]»] [E]m) "[Z'sch Tutorial folder B (@Qseareh

Name i P ;

*
@ Network !
= Boot Drive B 5 PCB Project Example ECO
=4 Dev t
=4 Misc i
=4 Volume 3 i
(=} Drives |
! Driveb !
[] FreeAgent Drive ||

Figure 1-25 « Locating the ECO Document
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6. You will next be presented with the ECO Import Options.

r ]

ECO Input Options

ECO SOURCE DESIGN:
Mame : PCB Project Example
Kind: Schematic
Rewv: 18/2/08 2:88 PM

|  Cancel |
= Import Component Changes Only
[} Auto-Disperse Thermal Connections

Figure 1-26 « ECO Import Options

7. Continue by selecting the Import button.

PCB-ST will compare the incoming ECO file with its empty condition in the
new window. It will scan its current list of libraries looking the necessary
footprints specified in the ECO document. These footprints will be placed
at the bottom of the design work surface.

8. Once the import is complete scroll the view downwards to reveal the
footprints that have been pulled from the ST libraries and placed at the
bottom.

cz J1 R1 Rz R3 R4 RS R& R7
— G:D% ¥ ] ] ] ] ] ] 1+ ] 1+ ]+ 1+ ]+ 1+]

g \ Wrong Footprint

Figure 1-27 « J1 .. Missing Footprint Symbol

1

i

QOO0
[sXeXeTs)

You should see that most of the desired footprints have either been
created or pulled into the work area. However you should note that there
is a problem. J1 does not have the correct footprint. A symbol similar to
one you see for J1 will be used anytime the correct footprint for the
requested footprint can not be located within the ST's currently known list
of footprints. In this particular instance the footprint did not exist and so it
must be created before we can proceed with our design.
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Creating a needed footprint

9. We will create this needed footprint in the Library Editor window and
save it into a new Library file created just for this exercise.

10.In the Library Access button found in the top tool bar click with your
mouse. A pop-up menu will appear and within that pop-up select

EE) NEW.. which will allow you to create a few library file which will hold
the footprint we are about to create.

B [e]a]=]s]
T

Open...
Convert ASCI...

{
Find...
Find Next

Folders »

Figure 1-28 « Creating a New Library File

11.This cause a PUT dialogue to appear. Give this file the name
TutorialExample.plb and save the file to the same directory as the
application.

[ Important Note:
Saving to same directory as the application is important for this
exercise. Later you can read in the main manual about relocating the
library if you decide to keep it.

TutorialE... | =
EMPTY

12. The system will open this file and scan for the first footprint in the list.
Since this is a new library it will be empty.

13. With your mouse click below where it says EMPTY. This will cause the
menus to focus towards the library editor.

14.In the File menu select the NEW Library Footprint.. . command.

New Library Footprint... BN .
{ Open Library Footprint... 30 E
H

Close Library EW 7

Figure 1-29 « Opening an New Library Editor
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15. A new Library Editor Window will now appear.

'® 06 0 New Symbol 1 7]

| HEsEnnEEE

' H+ BEDEBEEBE

i z
0
i [

_l:i-ame
Ref Des

| r'Y

| -

& el

Figure 1-30 « Untitled Library Editor Window

This editor window will be very similar in design and function to that of the
main design window, however its primary use is solely for the creation of
footprints.

16. Select Data Layer 2 in the top tool bar. Then select the round doughnut
pad in the left tool palette. Starting at location 0,0 place a total of six
pads in any arrangement you wish. You can copy the figure below if
you wish.

O . !—1 a 1 2 m

Figure 1-31 « Placed Pads and Silk Outline

17.Select Data Layer 1 and using the line tool from the palette on the left
draw an outline of the connector.
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Assuming that you placed the pads consecutively they should be
numbered 1 to 6 as needed in the schematic. You can check the pin
numbering by first selecting the pointer from the tool palette and then
switching back to Data Layer 2. When you click on each pad
individually the information about each pad will display on the left
below the tool palette. If the numbering is incorrect double-click on the
pad itself to bring up its labeling dialogue and relabel the pad as
needed.

18.0Once you are happy with the footprint select SAVE from the File
menu.

19.In the labeling dialogue which appears enter MyOwn6Pin so that it will
match the name we used in the schematic we created earlier.

r ]
Save Symbol As:
My Owen 6Pin

|\ Cancel | ( Save )

Figure 1-32 « Labeling the PCB Footprint

20. Close the Library Editor Window.

Having created the needed footprint we can now return to the main design
window. There are several ways to replace the problem footprint in our
design window. In this example we will simple delete the footprint and re-
import the ECO we did earlier.

21.With the pointer select the bad footprint. It will highlight. Then hit the
Delete Key.

22.Go back to step step 5. on page 26 and import the ECO again.
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23.Your updated ECO import should look similar to the figure below.

TutorialE...| =1

Mdwné... g R1 RZ RZ Ra RS RE RT

[+ 1+ ] 1+ ] 1+ ] 1+ ] 1+ ] 1+ ] i+]

QOO0

]

Figure 1-33 « PCB Footprints after last update.

24.Reposition your view so that you can see the perimeter of the board
we created earlier.

[J Note:
At this point all of the footprints are marked as having been un-placed;
meaning that they are not in position. Once you drag or move these
from their initial position they will lose their un-placed status.

Arranging the footprints

We will next position the footprints into their final positions within the board
perimeter we created earlier. This can be done a number of different ways,
however for this demonstration we will use the most simple method which
will also demonstrate the dynamic reconnect of the nets as well.

25.In the Utilities menu in the Dynamic Place submenu select the Get
Unplaced Device . You can also use the keyboard short cuts. Using
this command will get the first un-placed device from the software’s
internal list and attach it to the tip of the mouse pointer.

CTRL U (MS Windows)
CMD U (MAC 08X)

26. Move the mouse pointer to the desired location. While attached to the
pointer you can use the rotation buttons in the top tool bar to change
the orientation of the device that is attached. You will also note that the
rat lines will rubber band as you move the footprint. While moving the
footprint the system will recompute the shortest path to any connection
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point that is a member of that same net. This can be used to help you
determine the best placement to minimize copper track cross-overs.

27.Click the mouse when you are ready to anchor the footprint at the
desired location. Repeat the previous two steps until you have placed
all of the devices as shown in the following figure.

|

?g:::z |>§
e
ﬁ::z e
EMPTY N ] ag:::z i E =
= , -
gg;:z
iﬁ:zz
Sy

Figure 1-34 « Placed Footprints

28.Refresh the screen as needed using the Redraw Screen command in
the Layout menu.

Manually Routing the Interconnects

Once you have the footprints in position, you are ready to begin
interconnecting the various pins. The Net List has been imported through
the ECO process and the Rats Nest which was created from it, resides on
layer 20 which is currently in the NoDraw mode and thus is not being
displayed.

29.To enable the display of the imported nets list we shall use a shortcut
technique. Move your pointer over the data layer button (in the top
toolbar) which contains the rats nest; usually layer 20. While
depressing the OPTION Key (Mac) or CTRL Key (Windows) click the
mouse button once. You should observe that the over-score line in the
button will disappear. When the over-score line is present this
indicates that that layer will not be drawn when the screen is refreshed.
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30. Refresh the screen display.

| steer ||

1
- o
EEBUANL cm)
i ﬁ; £
| .f 1
i G e
EMETY | ] o T e |-
L o b
e

Figure 1-35 « Layout with Rats Nest layer enabled

Before beginning the routing let’s quickly review the various cursors that
the system will display.

>< Dragging Trace Junctions & Vias
: Un-Constrained
- ¢ Dragging Segments
Constrained

/ \ Resizing 45° Segments

Constrained

Dragging Segment Intersections
Donut Star Pointer

Un-Constrained

/ \ Creating 45° Segments
/ \ Constrained

Figure 1-36 « Wire Movement Cursor Types
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Clicking on a rat line or existing piece of copper track will cause one of
these movement cursors to appear indicating which way you have
available movement. You will observe that some operations will
automatically have imposed directional constraints.

[ Important Note:
Remember that when you click on either a rat line or copper track the

data layer associated with the item MUST be currently active
otherwise nothing will happen. The currently active layer is the one
with the blinking button in the top tool bar.

Since we will next be demonstrating the use of STEERIng there are two
additional Cursors which the system will display depending the mode we

STEERIng are in.
Switch

Select Net Select Track

Figure 1-37 « STEERIng...Net and Track Finding Cursors

Initially the system will ask you for the Net you wish to work with. That
cursor will have the “N” in it. Click on a Device pin or copper track will
identify the signal you plan to work. The entire net will high light and the
cursor will change to one containing the letter “T” . The high lighted net will
have one or more rat segments. Move the hot point over the desired
segment and click the mouse button to select the segment for
manipulation. Once the segment is located by the system, the cursor will
change yet again to indicate that you have un-constrained movement.
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Steered/e

Track

Figure 1-38 « Un-Constrained Steering Cursor

You will also note that both ends of the rat line are anchored to their source
and terminus as well as the mouse’s hot-point. The rat will rubber band
with the movement of the mouse and every time you click the mouse you
will anchor a copper track leg on the currently active data layer. While in
this mode you can change data layers while routing the path to the
terminus. If you change layers the system will automatically insert vias as
needed. Upon reaching the terminus the cursor will switch back the
STEERIng “T" cursor so that you can select the next track in the net if
there is one.

To stop or begin working with a different net, hit the ESC Key and you will
see the STEERIing “N” cursor appear allowing you to select a different net.
31.Select Data Layer 3.

32. Select the STEERing Switch in the routing Tool Bar on the left.

33. Move the pointer to the lower-left pin on J1. This will high-light the rat
line.

34.Next click in the highlighted rat line on the end to the J1 pin.
35. Route the path as shown.

& T iy =y SER AL WD
i i DR
b T : l"‘.
7 et )t - o

iy

5

Figure 1-39 « STEERIng First Highlighted Net.
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36. Hit the ESC key so that we can now select a different net.

37.Repeat this STEERIng sequence with other rats. Use the following
figure as a guide.

Figure 1-40 « More STEERed Signals

U Note:
If you decide to switch trace layers to avoid a collision with another
trace the software will automatically insert a via for you at the last
anchor point prior to making the layer switch.

You may continue manually routing this design until completed. However
we will take this opportunity to demonstrate taking this partially routed
design into the optional autorouting software module to have this tool finish
the routing of the board for you. If you do not plan to use any autorouting
capabilities then complete the manual routing of this design and then
proceed to Power Planes & Thermal Pad Set-up on page 40.

To use the autorouting environments you will need to export a router
document.
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38.In the File Menu select Export-> Trailblazer.

Import b B

ECO...

Printer Setup... | Plotter FAB File...

| Plotter CHK File...
| Plot Options...
- Preferences |
ey : e
I ¢ %= Tracker...
l P Y=y

Figure 1-41 « Exporting Trailblazer Document

39.In the file Put Dialogue which appears, label the file as
"PCB_Tutorial.tbs" . This document will be brought into the
autorouting environment in the next section.

0.6 (&) Save As Trailblazer Doc
N T B
(Eim v Q search
e S 4| Date Modified

% Network
= Boot Drive
=4 Dev
=4 Misc
=4 Volume 3

Figure 1-42 « Labeling the Trailblazer File.

Using the Optional Auto-Routing Tools

The McCAD environment offers you a choice of two autorouting tools.
They have basically the same interface and only differ in capabilities and
level of robustness. Trailblazer is the most capable will be demonstrated
next.

40. If you have not already done so, install McCAD Trailblazer on your

‘ machine.

Trailblazer 41.Launch the McCAD Trailblazer application by double-clicking on the
icon.
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42. As the application launches you will we presented with a open file
. dialogue. Locate the file "PCB_Tutorial.tbs" which was saved
earlier, select it and then open it.

PCB_Tutorial .TBS 43.The file will open and display your partially routed design.
==

(][] [£7][=][ 2]

Figure 1-43 « Partially routed design.

[ Auo At this point since we are dealing with a very simple and straight-forward
e — layout, we will turn the routing over to the Autorouter engine. With more
Resume Sweep Router  complex and higher density designs you have the option of doing some
Run CDE Sweep pre-route optimizations and set-ups which will improve the finished results.
Run DFM Sweep You should review the Trailblazer manual at the appropriate time when

Run DRC Sweep... H
Run Space Check Sweep you are working at that level.

[ |

44.In the AUTO Menu select the Route Window command. The routing
| Window CDE will begin and complete quickly. You will be presented with a

Window DFM . . . . L.

Window DRC... completion dialogue which you will close by clicking the OK button.

' Routed 16 connections in 0 seconds.
Total is now 21 out of 21 (100%).

Figure 1-44 « Routing Completion Dialogue

o)
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45. Upon screen refresh your finished design should appear.

AN

°

Figure 1-45 « Autorouted Design

For those who have a n enabled version of Trailblazer you would save the
file for return to PCB-ST environment. Those using Trailblazer in Demo-
Mode we have provided a copy of this saved file so that you can continue
with the balance of this tutorial.

Importing the Routed Data File

We are returning to the PCB-ST environment at step 39. on page 37 of this
tutorial and resuming the completion of this project.

46. In the File Menu select Import->Trailblazer . In the Open dialogue
locate the “PCB_Tutorial_rtd.tbs” . This is the routed design file
which we have provided for those who only have the demo-mode
version of Trailblazer. Import this file.

©VAMP Inc. McCAD® EDS Quick Start Guide



1-40 Simple PCB Project

Similar to importing an ECO, bringing in the routed track data from
Trailblazer, you are presented with some options.

E Input Options )
Set File Input Options:
Auto-Thermal Placement
(;j Replace Existing Traces
: Append To Existing Traces

Figure 1-46 « Import Options Dialogue.

We will continue however we did not set up for thermal planes earlier and
so thermals will not be automatically created and deposited even though
there is a check mark present in the dialogue. We will manually disperse
the thermals later.

Figure 1-47 « Trailblazer Route Data Imported Back to ST

Power Planes & Thermal Pad Set-up

As mentioned previously we had not setup out project to automatically
handle the dispersal of Thermal pads (as needed) prior to importing either
the ECO or the return of routed track data. Since we will be demonstrating
Split Planes in this tutorial we will now show how to do the setup as well as
create the planes.
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To use the automatic thermal dispersal feature the PCB-ST system
requires us to first specify the data layers which will be associated with
those signals which will be connected to an appropriate plane via a thermal
type pad. The association is accomplished by assigning the same name to
a data layer as the name of the signal. For example, a specific data layer
would be renamed to “GND” thus linking it to the signal net “GND”. During
the dispersal process the software would then know to place all thermal
pads belonging to that net on that data layer at the appropriate locations.

47.In the ART Menu select “Assign Layer Attributes.. .

____________ _

Construct Fabrication Tool...
| Display Fabrication Tool. .. |

Construct Check Print Tool...
Display Check Tool...

| Assign Layer Attributes... [

Figure 1-48 « Reassigning a layer name

48. In the dialogue that appears scroll down on the left to Layer 14 and
select it. Then click on Edit Layer Name .

Selected design layer has checked Attribute Type

List of Design Layers: Type Attribute:

L11: Targets - Top Silk

L12: Tooling Holes Top SolderMask

L13: Plating Bars Common Pads
# L14: Thermals: Gnd Top Pads

L15: Thermals: Pwr Top Traces

L16: Mask Lines: Pwr Inner 1

L17: Mask Lines: Solder Inner 2

L18: Mask Lines: Gnd Inner 3

L19: Inner 4

L20: Rats Nest i Inner 5 i

L21: ¥ Inner & v

#ﬁ Edit Layer Name (" canceL ) ( oK )

Figure 1-49 « Selecting Data Layer 14 for Name Change
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49.In the next dialogue type GND. Then click OK

~

Label for #14

GhD

( cancel | o)

Figure 1-50 » New Layer Label

50. Close the data layer attributes dialogue.

U Note:
Having set the Name of the Data Layer any time we import an ECO, a
netlist or manually disperse a net the system will automatically handle
the creating of thermal pads, providing that all the conditions are met.

At this point we will also reset the color for data layer 14. Doing so will help
to quickly identify the presence of the thermal and its potential. (One can
assign a different color for each potential.)

51.In the Layout Menu select the “Layer Display Settings.. .”. In the
dialogue which appears select layer 14 and in the color palette on the
right assign the light cyan color to this layer.

9 Color () Black and White

No. | Color | MName

g Top Pads

9 Bottorn Pads
10 Info (Copper)
1 Targets

12 Tooling Holes
13 Plating Bars

»14 GMD

15 Thermals: Pwr Pattern

16 Mask Lines: Pwr . "solid =
17 Mask Lines: Solder v

i

(" Use Factory Settings ) (" cancel ) ( OK )

Figure 1-51 « Assigning a Layer Color

52. After assigning the color click OK to close this dialogue.
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Manual Thermal Pad Dispersion

Now that we have completed the setup for thermal pads we will use the
automatic feature found in the software to place thermals as needed. In

NES this simple project we have only a single net upon which we will be

|k dispersing thermals. It's labelled GND.

| s 53.1n the tools palette on the left navigate to the trace routing tool palette.
This will cause the Nets Menu to appear in the Menu Bar at the top.

54.1n the Nets Menu select “Disperse Thermals on Net....” . Inthe

Routing Tools dialogue which appears type GND for the name of the net.

Disperse Signal Below with Thermals

cMD

( cancel ) (_Disperse)

Figure 1-52 « Specifying a Signal for Dispersion

55. Upon clicking on the Disperse button the software will locate the GND
signal and then locate a layer bearing the same name. If found (we
relabels a layer earlier) it will proceed to place thermals on that data

layer.

Preparing for a Split -Plane
We will demonstrate the necessary steps to split a plane even though in
this specific project it is not truly necessary since we have only one plane
signal; GND.

56.In the Data-Layer Button bar click layer 18 to make it the active layer.

Figure 1-53 « Selecting Simple Graphic Line
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57. Select the Simple Graphic Line tool. Set the line thickness to 0.020".

58. Draw a line similar to the one shown.

L i
e Bemmmne )
1] A "y k_.r
. (P .
RE TN W
L pra=
Ok il
Start ] H F il - la) -
F‘Ea 1x

>

o Finish

=

N Aty 3
o]

Figure 1-54 « Drawing the Split Line on Layer 18.

Making The Power Planes

The finished Plane is usually a combination of a number of masks. The
number of masks needed to produce a single Plane depends upon the
complexity of what is needed. The masks are produced using the Make
Special Tooling command found in the Edit Menu . In the following
exercise we will make a single plane which is split.

59. Select the Make Special Tooling command to bring up the dialogue.

-

¥ Make Special Tooling
Tool Kind: | Gnd/Pwr Plane ﬂ
Source Layer: FERE Grow Radius: 10
Destination Layer: F - Perimeter Inset: 0
l _. Done ._ )| _.Make Tool ._ )

Figure 1-55 « Special Tooling Dialogue

60. Make sure that you have selected Gnd/Pwr Plane for the Tool Type.
The source layer is 2 and the destination for the Mask is layer 29. The
Grow Radius (or Gap) should be set to 10 mils.
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61. Select the Make Tool button.

62. The mask generator will begin but first it will ask you to confirm that you
want the area around the feed-through vias to be cleared. You should
answer ADD.

Mask ALL FeedThroughs and add them to this tool.

( DontAdd )  Add )

Figure 1-56 « Confirming Via Clearance additions

63. When then mask is finished you will be notified.

The Plane Mask has been created on layer 29

[ _' Done ._ ) ( Continue )

Figure 1-57 « Completed Mask Info Dialogue

64. Select Continue . This will return you to the Make Special Tooling
dialogue so that we can continue constructing the plane.

65. Next we need to create a mask containing the clearances for the top
side traces. Change the Source layer to 3 which is the top trace layer.

66. Select the Make Tool button.

67. The mask generator will begin again, but first it will ask you to confirm
that you want the area around the feed-through vias to be cleared.
This time you will answer Don’'t ADD . This is because we already
have a mask which contains the clearances. Adding any more just
wastes memory.

68. Select Continue . This will return you to the Make Special Tooling
dialogue so that we can continue constructing the plane.

69. Next we need to create a mask containing the clearances for the split
line we drew earlier on data layer 18. Change the Source layer to 18.

70. Select the Make Tool button.
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71. The mask generator will begin again, but first it will ask you again to
confirm that you want the area around the feed-through vias to be
cleared. This time you will answer Don’t ADD . This is because we
already have a mask which contains the clearances. Adding any more
just wastes memory.

At this point we have three separate masks residing on data-layer 29 all on
top of one another making it difficult to see the desired result.

Figure 1-58 « Un-merged Masks

These individual masks will be combine into a single finished composite
mask.

Figure 1-59 « Selecting the masks with a area marquee

72.Make data-layer 29 the active layer.

73.Using the mouse in pointer mode, begin outside the mask perimeter.
Depress the mouse button and drag diagonally into the body of the
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mask and then release the mouse button. It is not necessary to
enclose the entire mask area.

[0 Warning;
Avoid falling into the trap of using the Select All or Select All Visible
commands. Following the steps described above will avoid
accidentally including inappropriate features into a merged mask and
possibly damaging your work to this point.

74.1n the Edit Menu select the “Merge Objects...” command. You will
receive a warning dialogue which give you the chance to cancel this
operation.

Merge Hilited graphic objects.

| . NO . ) ‘ _ Merge ! ’
Figure 1-60 « Merge Mask Confirmation

75. Click the Merge button.

Figure 1-61  Multiple Masks Merged into single mask

76.To improve clarity, use the technique shown earlier to reassign layer
29's color to a Light Brown.

77.Disable layer 18 so that it will not be drawn to the screen.
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78.Make data-layer 2 the active layer and select the redraw command to
refresh the screen.

Figure 1-62 « The finished design.

The design is nearly complete. You can zoom in and examine the area
around the thermals. Please note the spokes which contact the plane. You
can change the spoke orientation through a Global preference located in
the Design’s Preference dialogue.

Thermal Pad

Making the Drill Template

In preparing the design for manufacture you will need a drill list. This is
made from one or more drill templates contained in your design. The
number of templates will depend on the overall complexity of your project.
Most projects usually only need one single template. In this project the
design is very simple and thus we need to create just a single template.
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1. Inthe Edit Menu bring up the Make Special Tooling dialogue once
again.
Make Special Tooling

Tool Kind: | Drill Template I :]

Source Layer: 2 [+] Grow Radius: 10

Destination Layer: 26 E Perimeter Inset: 0

(" Done ) ( MakeTool)

Figure 1-63 « Special Tooling... Drill Template

2. Inthus design all of the drill holes are located on layer 2. The Drill
template will be placed on its default layer 26. Select the Make Tool
button.

Add ALL FeedThroughs to this tool.

(‘Don'tadd ) (- Add )

Figure 1-64 + Adding Vias to Through-Hole Template

3. Click the ADD button to add the vias to the drill template. If vias are
found you will be notified.

r Al
McCAD Via holes were found and added to the Template.

Figure 1-65 « Drill Vias Found
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4. You will next be asked if you wish to keep any previously created Drill
Templates. In this case since we have not created any previous drill
templates either choice will yield the same result.

r hl

Do you wish to keep previous DRILL Templates
or delete them?

Figure 1-66 « Option to Keep Previous Templates

5. The next dialogue confirms what we have done. Hit the DONE button
since we will not need to create any more Drill Templates.

The Drill Template has been created on layer 26

\ _. Done ._ ] ( Continue )

Figure 1-67 « Natification of Template placement

6. Save your PCB design file and quit the application.

You are now done with the design portion of this project. We will next begin
the production of the manufacturing documents.

Manufacturing Outputs

Depending upon what you board fabricator requires the PCB-ST system
will produce either Gerber and Excellon format document or the integrated
design file format known as GenCAD (aka, GenCAM, IPC 2581 subset).
The latter can be found in the FILE menu under Export -> Drill & Other.
We will discuss the Gerber documents as they are more commonly used,
however the integrated file approach may become more dominant in the
coming years.
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Making Gerber Plot Files

(0.LAL
d 1. Launch the Gerber Translator Utility.

McCAD-Gerber2 . . .
2. If a the file Get Dialogue does not appear go to the File Menu and

select OPEN PCB-ST File. Locate the design file you save in the
previous section and open it.

3. Your design file should appear in a window.

Figure 1-68 « Simple PCB Design Project

4. Inthe Gerber Menu select the “Sort To Aperture Table...” command.

Convert with Multiple Apertures

Sort to Gerber Aperture Table...
Edit Aperture Table...
Print Aperture Table...

Gerber Options...

This a very important step as it will insure that an efficient Gerber file
will be created. The software will thus scan your design and build a list
of required graphic features needed to efficiently reproduce your
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design using the 274X Gerber standard. The table will be organized
based on frequency of feature use.

Sorts the database to build an aperture table for the most
frequently used elements. If there are more elements than
will fit in the aperture table, then the |east frequently used
are drawn with D10 (which should be a 0.010" round).

Maximum aperture size Maximum aperture count
() 0.250" (6.35 mm) ()24

® 0.400" (10.2 mm) ()64

Os.o @ 240

Source layers

® Sort from all layers

() Sort from layers 1 to 32

Plotter does not support positive thermals
@ Separate Flash and Draw codes

Figure 1-69 « Gerber Sorting Dialogue

5. Prior to the completion of the Scan and Sort operation you will
presented with options dialogue which controls the results of the
sorting process. The default settings are what you will be using most
of the time. Click Proceed .

6. You can view the results of the sorting by selecting “Edit Aperture”

7. Inthe Gerber Menu select the “Convert with Multiple Apertures..”
to begin the Gerber file creation process.

8. You will be asked to confirm whether the Aperture Table (a.k.a.,
Aperture Wheel) is appropriate for this project. Since we just did a sort
we answer YES to continue. You would answer NO if you needed to
load a specific predefined table or you had forgotten to do the sort.

9. The next dialogue allows you to position the Gerber Image. You would
do this if you were trying to combine a number of Gerber images into
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a single Production Gerber document. In most cases you will just leave
the offset at 0, 0 an click OK to continue.

r ]
Plotter Origin

SET PLOTTING WINDOW ORIGIN

OFFSET RANGE: -32000 to +32000
Horizontal: 0

Vertical: 0 I_.. Cancel .l_l ( oK )

Figure 1-70 « Gerber Output Image Offset Option

10. The next dialogue allows you to select the Gerber Fabrication
Negatives (Tools) you wish to create.

Select Tools for Output )

Checked Fabrication Tools are enabled

Fabrication Tools: Tool Contents:

¥ Tl Top Legend L2 Common Pads
Check T2: Top Solder Resist m L&: Bottom Trace
Marks ¥ T3 Top Copper L9: Bottom Pads
Indicate T4: Inner Signal 1 L11: Targets

TS Inner Signal 2
Tools ¥ T& Bottom Copper #
to be T7: Gnd Plane

Generated T8: Pwr Plane .
T3: Bottom Solder ...

Select All |

I__. Clear All Selections .__I [ CANCEL | ( oK )

Figure 1-71 » Selecting the Gerber Tools

11.When you select each tool on the left the data-layer contents that
make up that selected tool are displayed on the right. This allows you
to check before committing to the Gerber file creation. Once you have
selected the tools you will need and a check mark appears next to
those desired tools click OK.
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12. Before producing the output you have one more option to select.

r |

Do you wish all text to be plotted only with a
single pen pass?

NO ) ¢ YES )

Standard Gerber does not support a character set. Therefore all text
strings must be drawn by the Gerber generator. If in your design you
marked any text as BOLD the generator will do a second pass to fatten
up the text marked as BOLD. Doing this is not recommended for small
text. Therefore this dialogue allows you to limit text drawing to a single
pass regardless of whether it is marked BOLD or not.

13. Select the YES button for this demonstration. The Gerber files will now
be created. and placed where you have directed the system.

el (&) Save Gerber File As N
Save As: | GrbT1_PCB_Tutorial_F1.gbr [+]
Where: [ [/Sch Tutorial folder ﬂ

A

Figure 1-72 « OS System Appropriate PUT dialogue
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Making the Excellon Drill files.

The production of the Excellon Drill files can be done either in the PCB-ST
design module or, as we will now demonstrate, in the Gerber translation
utility.

14.In the Utility Menu select “Export Drill & Other...”

B Export CAD File K

Select File Kind: = Excellon Drill List ﬂ

{ Cancel ) E—E!purl—a

Figure 1-73 « Selecting the Excellon Drill List

15. Select the Excellon Drill List in the Pop-Up Menu and then click
EXPORT..

16. In the next dialogue specify how you want the file labeled and where it
is to be put.

r . . hl
Drill Data Segmentation Control

®) Do Not segment File ouput
) Limit File Size ( ok )

to space available on the —_—
indicated paper roll length of

") Meters @) Feet

17.Next a file segmentation dialogue will appear. Simply click OK.
Segmentation may only have to be done on very large designs which
have upwards of ten thousand holes. Your fabricator will tell you when
he needs this to be done.

Please specify the OS for which the extracted file is
targeted.

I__. Windows .__I ( Mac 0S )

Figure 1-74 « Selecting OS Target Format
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18.1tis best to select Windows in most cases since most Fabricators have
Windows OSes and some of their drill handling software my cause
them problems if you send it to them in MAC OS format.

19. Finally there are two Excellon Formats. Select # 2 in most cases since
it is a newer format.

F Al

Select the desired Excellon Format. #2 is
usually preferred.

#1 ¢ #2 )

Figure 1-75 « Selecting Fabricator’s Excellon Format.

20. Take the Gerber and Excellon document which are created and place
them into a compressed archive so that you can send them to your
board fabricator.

21.Close all McCAD Applications.
This completes the tutorial.
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